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FCC DECLARATION OF CONFORMITY
(TARGA Ciné PCI SERIES)

This equipment has been tested and found to comply with the limits for a Class A only digital device,
pursuant to Part 15 of the FCC Rules.  These limits are designed to provide reasonable protection
against harmful interference when the equipment is operated in a commercial environment.  This
equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in
accordance with the installation manual, may cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful interference in which case
the user will be required to correct the interference at his own expense.  Any changes or modifications
not expressly approved by Pinnacle Systems could void the user’s authority to operate this device.

 WARNING To minimize emissions from your system, use only shielded
interface cables and certified Class A peripherals.

Official Notices And Warranties

Legal Stuff
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DECLARATION OF CONFORMITY

Application Of Council Directive 89/336/EEC

Standards to which Conformity is Declared:
EN 55022 and EN 50082-1

Manufacturer's Name: Pinnacle Systems Inc.

Manufacturer's Address: 280 N. Bernardo Avenue
Mountain View, CA  94043

Type of Equipment: PCI Display Card
(Macintosh Platform)

Model Name: TARGA Ciné

Tested By: EMC Compliance Management Group
670 National Avenue
Mountain View, CA  94043  USA

Manufacturer's Test Engineer: Frank Davis

I, the undersigned, hereby declare that the equipment specified above conforms to
the above Directive and Standard.

Name (please print):   Carl Calabria

Title:   Vice President of Engineering

Signature:

Date:   18 July 2000
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LIMITATION OF LIABILITIES

This manual and the enclosed software was prepared by Pinnacle Systems, Inc.  While the authors and
program developers have taken reasonable care in preparing this manual and the files on the enclosed CDs to
assure their accuracy, the authors assume no liability resulting from any inaccuracy or omissions contained
in them or from the use of the information or programs contained herein.

WARRANTY DISCLAIMER

The authors and Pinnacle Systems Inc. make no warranties, expressed or implied, including without limitation
the implied warranties of merchantability and fitness for a particular purpose, regarding the software and
hardware.  The authors and Pinnacle Systems Inc. do not warrant, guarantee or make any representations
regarding the use or the results of the use of the software and hardware in terms of its correctness, accuracy,
reliability, currentness or otherwise.  The entire risk as to the results and performance of the software and
hardware is assumed by you.  The exclusion of implied warranties is not permitted by some jurisdictions.  The
above exclusion may not apply to you.

In no event will Pinnacle Systems, and its directors, officers, employees or agents (collectively Pinnacle Systems)
be liable to you for any consequential, incidental or indirect damages (including damages for loss of business
profits, business interruption, loss of business information, and the like) arising out of the use or inability to use
the software and hardware even if Pinnacle Systems has been advised of the possibility of such damages.  Because
some jurisdictions do not allow the exclusion or limitation of liability for consequential or incidental damages,
the above limitations may not apply to you.

LIMITED WARRANTY

Please refer to the enclosed addendum for specific information on TARGA limited warranty terms and
conditions.

END-USER LICENSE AGREEMENT

IMPORTANT-READ CAREFULLY:  This Pinnacle Systems End-User License Agreement is a legal
agreement between you (either an individual or a single entity) and Pinnacle Systems Incorporated for the
Pinnacle Systems software and hardware product(s) accompanying this End User License Agreement, which
include(s) computer software and may include “online” or electronic documentation, associated media, and
printed materials (‘’PRODUCT’’). By installing, copying, or otherwise using the PRODUCT or any
UPDATES (as defined below), you agree to be bound by the terms of this End User License Agreement. If
you do not agree to the terms of this End User License Agreement, do not install, copy, or use the
PRODUCT, and promptly return the entire unused PRODUCT to your place of purchase for a full refund. In
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addition, by installing, copying, or otherwise using subscription updates that you have received as part of
the PRODUCT (‘’UPDATES’’), you agree to be bound by the additional license terms that accompany such
UPDATES. If you do not agree to the additional license terms that accompany such UPDATES, you may
not install, copy, or use such UPDATES.

PRODUCT LICENSE
The PRODUCT is protected by copyright laws and international copyright treaties, as well as other
intellectual property laws and treaties. The PRODUCT can consist of circuits, product documentation,
sample applications, hardware and cabling, tools and utilities, miscellaneous technical information, and
development toolkits.

GRANT OF LICENSE
To the extent that you have elected to receive a PRODUCT from Pinnacle Systems Inc., Pinnacle Systems
grants to you as an individual a personal, nonexclusive license to make and use copies of the PRODUCT in
the manner provided below. If you are an entity, Pinnacle Systems grants to you the right to designate
individuals within your organization to have the right to use the PRODUCT.

LIMITATIONS ON REVERSE ENGINEERING, DECOMPILATION, AND DISASSEMBLY
You may not reverse engineer, decompile, or disassemble the PRODUCT, except and only to the extent that
such activity is expressly permitted by applicable law, notwithstanding this limitation.

SOFTWARE TRANSFER
You may permanently transfer all of your rights under this End User License Agreement, provided you
retain no copies, you transfer all of the PRODUCT (including all component parts, the media and printed
materials, any upgrades, and this End User License Agreement)

PRE-RELEASE CODE
Portions of the PRODUCT or PRODUCT UPDATES may be available as prerelease code (“Prerelease
Code”). Such Prerelease Code is not at the level of performance and compatibility of the final, generally
available product offering. The Prerelease Code may not operate correctly and may be substantially
modified prior to first commercial shipment. Pinnacle Systems is not obligated to make this or any later
version of the Prerelease Code commercially available. The grant of license to use Prerelease Code expires
upon availability of a commercial release of the Prerelease Code from Pinnacle Systems.

COPYRIGHT
All title and copyrights in and to the PRODUCT (including but not limited to any images, photographs,
animations, video, audio, music, text, and “applets,” incorporated into the PRODUCT), the accompanying
printed materials, and any copies of the PRODUCT, are owned by Pinnacle Systems or its suppliers. The
PRODUCT is protected by copyright laws and international treaty provisions.  Therefore, you must treat the
PRODUCT like any other copyrighted material.
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Introduction

Pinnacle Systems CinéWave

Be sure to register your TARGA Ciné Series product.  Doing so will entitle you to
software updates, answers to frequently asked questions, and put you on the TARGA
E-Mail distribution to receive important bulletins.  Either fill out the registration card
enclosed in the box (see Chapter 1), or register online at:  http://www.pinnaclesys.com/register

CinéWave system recommendations are as follows:

• Power Mac G4 Computer at 400 MHz or better
• Pro Analog, Pro Digital, or Pro HD Digital Breakout Box
• One or more Analog or High Definition compatible VTRs
• Analog or SDI (Serial Digital Interface) video monitor with speakers
• Cables for connecting your VTR deck, video monitor, and speakers

Your VTR should be the highest practical quality.  To take advantage of the capabilities of
TARGA Ciné in High Definition, we recommend a deck with SDI SMPTE 292M.  To take
advantage of the capabilities of TARGA Ciné in Standard Definition, we recommend a
deck with component-level outputs or SDI SMPTE 259M, although the TARGA Ciné does
accept S-Video and Composite Video.

Note:  For the latest information on what versions of Final Cut Pro or Commotion Pro can be used, or
what hardware is recommended, check the online compatibility guide at http://www.pinnaclesys.com

Using This Manual

Here is a quick overview of this manual’s Chapters and Appendices:

• Chapter 1 -- Discusses unpacking your TARGA Ciné card, installing the card, and connecting
input/output devices.

• Chapter 2 -- Gives instructions for installing the TARGA Ciné software and configuring the
TARGA Ciné system control panel for the card.
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• Chapter 3 -- Discusses setting TARGA Ciné specific software panel options within a
video-editing application such as Final Cut Pro and Commotion Pro.

• Appendix A -- Covers  CinéWave troubleshooting and provides information for contacting the
Pinnacle Systems Customer Support Center (for technical support and troubleshooting).

• Appendix B -- Details the TARGA Pro Analog Breakout Box rack mount installation.

• Appendix C -- Lists the technical specifications for CinéWave.
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Unpacking
The following items should be included in the Pinnacle Systems CinéWave package:

• TARGA Ciné card
• Pro Analog Breakout Box
• Anti-Static Wrist Strap
• Pinnacle Systems CinéWave software CD

Additions or options may include:

• Other complementary software CDs
• Pro Digital Breakout Box

 WARNING Do not remove the card from its antistatic bag until you’re ready to
install it.  Removing the card prematurely exposes it to static electricity,
which could damage it.

Product Information
The Warranty/Registration Card for your TARGA product can be found in the box.  Please
follow the directions on the card to register your product.

Also, please record the following information before you install your TARGA card.  This
information is necessary for Pinnacle Systems Technical Support to serve you.  If you
need assistance, see the Troubleshooting Appendix for more information on Technical
Support.

Purchased From_____________________

Purchase Date______________________

Card Serial Number______________________
(On underside of card)

Chapter 1:  Card Installation & Hardware Setup
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Digital Tether™ Connector 2

Digital Tether™ Connector 1 -- This 36-pin female connector is where a TARGA Analog and/or
Digital Breakout Box is connected for Standard Definition video.  The tether connector accepts input
from and provides output to a TARGA Analog Breakout Box in parallel ITU-R BT.656 format.  The
connector also inputs to and accepts the serial digital format from a TARGA Digital Breakout Box.

Digital Tether™ Connector 2 -- This 36-pin female connector is where a TARGA Analog and/or
Digital Breakout Box is connected for High Definition or Standard Definition video.  The tether
connector accepts input from and provides output to a TARGA Analog Breakout Box in parallel
ITU-R BT.656 format.  The connector also inputs to and accepts the serial digital format from a
TARGA Digital Breakout Box.

Figure 1-1  TARGA Ciné Card

Digital Tether™ Connector 1
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Installing The TARGA Ciné Card

Overview Of Hardware Installation
Complete hardware installation of the TARGA Ciné can be accomplished by doing the
following:

• Install TARGA Ciné card into the computer
• Attach TARGA Analog or Digital Breakout Box to TARGA Ciné card
• Connect input and output devices to Analog or Digital Breakout Box

Details for each of the items listed above can be found in this Chapter.

Card Installation Procedure

These are general-purpose installation instructions.  You should refer to the owner’s
manual of your Power Mac G4 computer (“Setting Up your Power Mac”) for additional
information on installing cards.  You should also refer to the “Read Me” files provided
with the TARGA software.

1. Shut down the Power Mac G4 computer and turn off the monitor.
Always shut down the computer before opening it to avoid damaging its internal
components.  To shut down the Power Mac G4, select “Shut Down” from the Special
menu and then wait 5 minutes so that the computer's internal components can cool.
Do not attempt to open the computer or install the TARGA Ciné card while the
computer is turned on.

Note: If you think the computer is in sleep mode, press the power button in front of the computer to
wake it, and then shut the computer down.

2. Except for the power cord, remove all other cables from the computer.
If you have never plugged in your Power Mac G4 computer, refer to the Power Mac
G4 owner's manual (“Setting Up your Power Mac”) for instructions on how to
properly set the voltage switch before plugging in the computer.
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3. Discharge static electricity that you may have on your clothes or body.
Use the Anti-Static Wrist Strap that is provided with your TARGA package.  Also,
touch the metal part of the PCI port access covers to discharge any static electric
charge that you might be carrying.  Refer to Figure 1-2.

4. Unplug the power cord, and then open the computer.
Lift the latch on the side of the computer to unlock the side panel.  Gently lower the
side panel onto a clean, flat surface.  Refer to Figure 1-3.

Important:  No LEDs should be glowing on the motherboard.  If LED lights are glowing, the
computer was not shut down.  Close the side panel and shut down the computer before proceeding.

Touch metal of PCI
port access covers

Figure 1-2  Discharge Static Area On Power Mac G4 Computer

1. Lift Latch

Figure 1-3  Opening The Power Mac G4 Computer

2. Lower Side Panel
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5. Prepare an expansion slot.
Locate an empty PCI slot (they are labeled 2, 3, and 4).  Then remove the port access
cover at the back of the computer’s expansion slot area by removing the cover screw
and then lifting off the port access cover.  Make sure that there are no obstructions to
the slot.  Refer to Figures 1-2 and 1-4.

6. Remove the TARGA card from its antistatic bag.
Make sure you are grounded via the antistatic wrist strap that is provided with your
TARGA package.  Handle the card by its edges and by its metal bracket.  Avoid
touching the connector pins on the bottom of the card.

7. Insert the TARGA card into the expansion slot.
With the bracket toward the open access port, align the connector on the bottom of
the TARGA Ciné card directly over the slot you’ve chosen.  Refer to Figure 1-5.
Then push down and gently rock the card lengthwise until the it is firmly seated.
When pushed into the slot, the card will catch as if it were in place – gently continue

Figure 1-4  Power Mac G4 Computer PCI Expansion Slot Area

Port Access Cover

Cover Screw
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to exert pressure until the card “seats” again or until you see that the card’s gold slot
connectors are barely visible and that the card  is completely installed.

Important: Don’t force the card.  If there is resistance, remove the card and try again.

8. Replace port access cover screw and close the computer.
Fasten the TARGA Ciné card into place with the port access cover screw.  Then raise
the computer’s side panel and press it against the housing until it snaps securely into
place.

 WARNING Do not turn on your Power Mac G4 computer unless all of its
internal and external parts are in place and it is closed.  Operating the computer when
it is open or missing parts can damage your computer or cause injury.

Figure 1-5  Inserting The TARGA Ciné Card

TARGA Ciné Card

Cover Screw
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9. Connect a TARGA Analog and/or Digital Breakout Box to the TARGA Ciné
card.
Connect the cable from the back of the Pro Analog and/or Pro Digital Breakout Box
to the Digital Tether™ connectors on the bracket of the TARGA Ciné card.  Refer to
Figures 1-1 and 1-6.

Important: We recommend that you do not disconnect or reconnect the Breakout Box cable from or
to the TARGA Ciné card while the computer is powered up.

Note: Two different types of TARGA Breakout Boxes (e.g., analog with digital) can be connected to
the TARGA Ciné card for simultaneous use.

Figure 1-6  Pro Analog Breakout Box Cable To TARGA Ciné

6-Ft. Cord

Pro Analog
Breakout Box

Digital Tether Connector For
Standard Definition Video

Bracket

TARGA Ciné
Card

Digital Tether Connector For
Standard Definition Video
Or High Definition Video
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About The TARGA Pro Analog Breakout Box

The TARGA Pro Analog Breakout Box supports XLR balanced audio, RCA unbalanced
audio, S-Video (YC), Component Video (Y, B-Y, R-Y), Composite Video (CV/CS),
Reference (synchronized or genlocked), and a key out (COMP-B).

Pro Analog Breakout Box Input And Output Connections

The input and output connections for the TARGA Pro Analog Breakout Box are defined as
follows:

XLR Audio: The dual-channel XLR connectors are for balanced analog input and output
audio.  Use the XLR connector labeled “L” for Left and “R” for right.

RCA Audio: The dual-channel RCA connectors are for unbalanced analog input and output
audio.  Use the RCA connector labeled “L” for Left and “R” for right.

S-VIDEO: If you are using an S-Video (Y/C) input or output source, use the S-Video
4-pin Mini-DIN connector.

Y   B-Y   R-Y: The BNC connectors labeled “Y,” “B-Y,” and “R-Y” are used for Betacam
and Betacam-J component input and output.  If a Betacam format is going to
be used, all 3 of the BNC connectors for input or output must be used for a
complete betacam signal.  “Y” is for Luma or Luminance.  “B-Y” and “R-Y”
signify color difference in a signal.

Figure 1-7  Pro Analog Breakout Box Input and Output Connections
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The color difference labeling Pinnacle Systems uses (Y/B-Y/R-Y) is a
standard representation of a Betacam Component video signal format.  You
may encounter others, such as Y/Pb/Pr or Y/U/V.  In these cases, attach the
Breakout “Y” to the Y connector on the peripheral, the Breakout “B-Y” to the
U or Pb/B connector on the peripheral, and the Breakout “R-Y” to a V or Pr/R
connector on the peripheral.

COMPOSITE: If you are using a Composite Video input or output source, use the BNC
connector labeled “Composite” for Composite Video (CV).

REF: “Ref” (Reference) is used to provide subcarrier field ID for the Component
outputs.  This is to be used when Y/B-Y/R-Y is selected as an input.  If “Ref”
is used, both it and the selected video source must be locked together.

COMP(B): Use to output to a second Composite Video device, or as a “Key” output
signal.  The output signal is provided for application software that allows an
8-bit Alpha channel for image blending information.  Availability of a Key
signal is a function of third party applications designed to take advantage of
this hardware feature of the TARGA Ciné.  This feature is not active in Final
Cut Pro or Commotion Pro.

TARGA Pro Analog Breakout Box Rack Mounting

Rack Mounting instructions for the TARGA Pro Analog Breakout Box can be found in
Appendix B.   An optional rack mounting kit for the TARGA Pro Analog Breakout Box
can be acquired from your nearest Pinnacle Systems reseller.  You can call the Sales
Information number listed in the “Contacting Pinnacle Systems” section of Appendix A to
obtain information on how to contact the reseller in your area.  Also, contact information
for Pinnacle Systems resellers can be obtained from the Pinnacle Systems website at:
http://www.pinnaclesys.com
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Connecting Audio/Video Input Devices
To TARGA Pro Analog Breakout Box

From your originating input source equipment:  Attach the audio and/or video output
connections of the equipment (e.g., Camcorder, VCR, VTR,  etc.,) to the “IN” connections
of the Pro Analog Breakout Box using the appropriate cables (XLR audio, RCA audio,
S-Video, and/or BNC).  Remember to connect from the output of your source devices to
the Pro Analog Breakout Box’s input connector(s).  For example diagrams, refer to the
following:  “Diagram 1: Analog Component VTR For Standard Definition Capture” and
“Diagram 2: Betacam SP Print-To-Tape For Standard Definition Video.”

Note:  If a Component signal is being sent by the source device to the Pro Analog Breakout Box, all three
Component In connections on the Pro Analog Breakout Box: “Y,” “B-Y,” and “R-Y,” must be used for a
complete Component signal to be received.

Connecting TARGA Pro Analog Breakout Box
To Audio/Video Output Devices

Attach the appropriate connections labeled “Out” on the Pro Analog Breakout Box using
appropriate cables (XLR audio, RCA audio, S-Video, and/or BNC) to the input
connections on each receiving output signal device (e.g., Analog Video Monitor, Speakers,
VCR, VTR,  etc.,.).  Remember to connect from the output of the Pro Analog Breakout
Box to your receiving output signal devices’ appropriate input connector(s).  For example
diagrams, refer to the following: “Diagram 1: Analog Component VTR For Standard
Definition Capture” and “Diagram 2: Betacam SP Print-To-Tape For Standard Definition
Video.”

Note:  If a Component signal is being sent by the Pro Analog Breakout Box to a receiving device, all three
Component Out connections on the Pro Analog Breakout Box: “Y,” “B-Y,” and “R-Y,” must be used for a
complete Component signal to be sent.



1-11Pinnacle Systems CinéWave

Diagram 1:  Analog Component VTR For Standard Definition Capture

Note:  Set the Remote/Local
switch on the deck to
“Remote” so that the deck
accepts RS-422 device
control commands.
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Diagram 2:  Betacam SP Print-To-Tape For Standard Definition Video

Note:  Set the Remote/Local
switch to “Remote” so that
the deck accepts RS-422
device control commands,
and set the Terminate Sync
Switch to “ON.”
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About The TARGA Pro Digital Breakout Box

The TARGA Pro Digital Breakout Box inputs uncompressed standard definition serial
digital interface (SDI) video to the TARGA Ciné card.  This breakout box also outputs
uncompressed standard definition serial digital video from the TARGA Ciné card.  The
Pro Digital Breakout Box connects to the TARGA Ciné card via the Pinnacle Systems
Digital Tether™ Cable.  Refer to Figure 1-8.  The supported SDI signal for input and
output is SMPTE 259/ITU-BT.656-3 and SMPTE 259/ITU-BT.656-4.

Note: Two different types of TARGA Breakout Boxes (e.g., analog with digital) can be connected to the
TARGA Ciné card for simultaneous use.

Connecting Audio/Video I/O Devices
To TARGA Pro Digital Breakout Box

From your originating input source component serial digital equipment,  attach the SDI
output connection of the equipment (e.g., Camcorder, VCR, VTR,  etc.,) to the BNC “IN”
connection of the Pro Digital Breakout Box.  Remember to connect from the output of
your source device to the Pro Digital Breakout Box’s input connector.  Then attach the
BNC connection for “Out” on the Pro Digital Breakout Box to the input connection on

6-Ft. Digital
Tether Cable

Figure 1-8  Pro Digital Breakout Box Cable To TARGA Ciné

Pro Digital
Breakout Box

TARGA Ciné Card

Digital Tether Connector For
Standard Definition Video

Digital Tether Connector For
Standard Definition Video
Or High Definition Video
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the receiving output signal device (e.g., SDI compatible Video Monitor or VTR).  For
example diagrams, refer to the following:  “Diagram 3: Capture And Playback For SDI
Standard Definition Video” and “Diagram 4: SDI Capture With Analog Playback For
Standard Definition Video.”

Diagram 3:  Capture And Playback For SDI Standard Definition Video
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Diagram 4:  SDI Capture With Analog Playback (Standard Definition Video)
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About The CinéWave Pro HD Digital Breakout Option

The CinéWave Pro Digital Breakout Option inputs uncompressed high definition (HD)
video to the TARGA Ciné card.  The CinéWave Pro Digital Breakout Option also outputs
uncompressed high definition video from the TARGA Ciné card.  The Pro HD Digital
Breakout Option connects to the TARGA Ciné card via the Pinnacle Systems Digital
Tether Cable.  Refer to Figure 1-9.  The supported SDI signal for input and output is
SMPTE 292M, SMPTE 274M (1080 Format), and SMPTE 296M (720P Format).

Note: Two different types of Breakout Boxes (e.g., analog with digital) can be connected to the TARGA
Ciné card for simultaneous use.

Connecting Audio/Video I/O Devices
To CinéWave Pro HD Digital Breakout Option

From your originating input source HD equipment,  attach the HD output connection of
the equipment (e.g., Camcorder, VCR, VTR,  etc.,) to the BNC “IN” connection of the Pro
HD Digital Breakout Option.  Remember to connect from the output of your source device
to the Pro HD Digital Breakout Option’s input connector.  Then attach the BNC

6-Ft. Digital
Tether Cable

Figure 1-9  Pro HD Digital Breakout Box Cable To TARGA Ciné

Pro HD Digital
Breakout Option

TARGA Ciné Card

Digital Tether Connector For
Standard Definition Video

Digital Tether Connector For
Standard Definition Video
Or High Definition Video
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connection for “Out” on the Pro HD Digital Breakout Option to the input connection on
the receiving output signal device (e.g., HD compatible Video Monitor or VTR).  For an
example diagram, refer to “Diagram 5: Capture And Playback For High Definition
Video.”

Diagram 5:  Capture And Playback For High Definition Video
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Enclosed with your CinéWave System is a CinéWave Software CD-ROM.  The CinéWave
CD-ROM contains an installation program which copies all of the software needed by the
CinéWave System onto your computer.  In addition, a folder named CinéWave is added to
your computer’s hard disk.  The CinéWave folder contains various files, including “Read
Me” files and other documentation.  An Adobe Acrobat™ Reader Installer is also provided
for viewing documentation that is in PDF format (Portable Document Format).  Refer to
the Read Me files after installing the TARGA Ciné software.

Note:  For the latest information on what versions of software should be used with TARGA Ciné, check
the online compatibility guide at http://www.pinnaclesys.com

Software Setup For CINÉWAVE

The CinéWave CD-ROM contains an installation program that automatically loads the
CinéWave software for you.  The following things may need to be done before using your
CinéWave product:

• Turn off “Virtual Memory” for the Power Mac G4 computer
• Make sure the Power Mac G4 computer’s VGA display color depth is set for “Millions.”
• Install your video-editing application software before you install the TARGA Ciné software

Virtual Memory -- CinéWave requires that virtual memory on the Power Mac G4
computer is set to off.  This can be done by opening the  “Memory” Control Panel (found
in the Control Panels folder within the System folder) and setting virtual memory to off.

Millions of Colors  -- The VGA display’s color depth on the Power Mac G4 computer
should be set to “Millions” so that the TARGA Ciné Overlay feature works properly.  This
can be done by opening the  “Monitors” Control Panel (found in the Control Panels folder
within the System folder) and selecting “Millions” for the monitor color depth.

About The CinéWave Software

Chapter 2:  Software Installation & Setup
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Installing The CinéWave Software
Do the following to install the CinéWave software:

1. Exit any open applications.

2. Install the software for your video-editing application at this time.
Install Final Cut Pro from the Final Cut Pro CD-ROM onto your Power Mac G4
computer.  Refer to the Final Cut Pro Installation documentation to do this.

3. Place the CinéWave CD into the DVD-ROM drive of your computer, and then
double click the CD-ROM icon to open the CD.

4. Double click the CinéWave Installer icon to open the installer, and then click the
“Continue” button.
Read the license agreement and then select that you agree with it to continue with the
installation.

5. Select the drive and folder you want the installation to occur into and then click
the “Open” button.
When the installation is complete, you must restart your computer before using the
CinéWave System.

Installing The Adobe Acrobat PDF Reader
To install the Adobe Acrobat Reader:

1. From the CinéWave CD-ROM, open the Acrobat Reader folder.

2. Double click on the Acrobat Reader Installer file and then click the “Continue”
button.

3. Select the installation location destination from the pull-down menu, then click
the “Install” button.
When complete, the Acrobat Reader can be used to view and print PDF documents.
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Configuring The TARGA Ciné Card
Settings must be made in the TARGA Ciné Control Panel (installed by the CinéWave
software installer) and the Sound Control Panel to configure the TARGA Ciné card.  Both
of these Control Panels can be found in the Control Panel folder of the Power Mac G4
computer’s System folder.  Settings must be made to these Control Panels before you use
the TARGA Ciné card.

Set the TARGA Ciné Control Panel as follows:

1. Open the TARGA Ciné Control Panel and click on the “Ciné Board Info” tab.

— The type of TARGA Breakout Box connected to Tether 1 and/or Tether 2
on the TARGA Ciné card will either be displayed or can be selected.  Possible
choices are as follows:

• None
• TARGA Analog
• Pro Analog and Digital
• Pro Digital
• Pro HD Digital
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2. Click on the “Video Settings” tab.

— Select the format of the type of video input going to your TARGA Ciné card.
The choices displayed are dependent on the type of TARGA Breakout Box being
used.  Your choices are as follows:

• NTSC Composite •  PAL Composite •  HD 1080i/PsF/29.97
• NTSC S-Video •  PAL S-Video •  HD 1080i/PsF/30
• NTSC Component •  PAL Component •  HD 1080i/PsF/25
• NTSC-J Composite •  HD 1080i/PsF/23.98
• NTSC-J S-Video •  525 Line SDI •  HD 1080PsF/24
• NTSC-J Component •  625 Line SDI •  HD 1080PsF/23.98

•  HD 720p/59.94
•  HD 720p/60

Note:  Where “In” is selected you are really selecting the active input, and the active outputs are
simultaneous.  For example if you select PAL Composite (In), then PAL Component and
PAL S-Video are active on output.
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3. Click on the “Genlock Settings” tab.

— Select the type of Genlock Source going to your TARGA Ciné card:

• Master/Freerun -- Use this option when genlock is not to be used.  Master/Freerun
instructs the TARGA Ciné card to generate output timing based on its built-in timing
circuits.  The output timing is not dependent on any external timing reference.

• The Type(s) of Breakout Box Connected -- The choices displayed are dependent
on the type of TARGA Breakout Box being used.  This option is intended for the
studio environment where there is a house sync as the external sync source.  The
TARGA Ciné generates its output timing locked to the reference signal (i.e., the card
genlocks to an external source).

— Select the Default Output to the screen during bootup or when no other image is
available.  The choices are blue, black, or color bars.

4. Close the TARGA Ciné Control Panel.
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Set the Sound Control Panel as follows:

1. Open the Sound Control Panel and click on “Input.”

— Select “TARGA Ciné” as the device for sound input.

— Select the input source for TARGA Ciné.  This pull down reflects the type or
types of audio input available on the TARGA Breakout Box being used.  If you
have an Analog Breakout Box connected, select “Unbalanced” if RCA jacks are
used for audio, or “Balanced” if XLR jacks are used for audio.  If you have an
SDI Breakout Box connected, the selection will include which stereo group of the
channels embedded on SDI are available for selection.

2. Click on “Output.”

— Select “TARGA Ciné” as the device for sound output.

3. Close the Sound Control Panel.
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Ciné Settings Within Video-Editing Applications

Chapter 3:  Application Specific Video-Editing Settings

The CinéWave software loads several TARGA Ciné specific controls into your video-
editing application.  These controls allow you to make direct settings to the TARGA Ciné
card for capture and playback.  The video-editing applications discussed in this Chapter
are:

• Final Cut Pro
• Commotion Pro

TARGA Ciné Settings Within Final Cut Pro

Within Apple Computer’s Final Cut Pro software-specific settings for TARGA Ciné are
made from within: “Preferences” within the Edit Menu, the Sequence Menu, and the View
Menu for “External Video.”  Video image adjustments that pertain to but are not specific
to the TARGA Ciné can also be made.  Once the TARGA Ciné specific settings are made,
use Final Cut Pro as you normally would for editing video.

Preferences Settings For TARGA Ciné
The Preferences for Final Cut Pro are accessed from the Edit Menu (Edit » Preferences).
Once Preferences are accessed, settings specific for the TARGA Ciné card occur within
the following tabs:

• General
• Device Control
• Capture
• Sequence Presets
• Scratch Disks

General Tab Settings
Within the Preferences’ General Tab of Final Cut Pro, a setting should be made for
viewing external video with the TARGA Ciné card.  The “View External Video Using:”
setting indicates to Final Cut Pro the type of TARGA Breakout Box (or Boxes) connected
to the TARGA Ciné card.  The TARGA option(s) displayed will be what was chosen in
the TARGA Ciné Control Panel (“Ciné Board Info”) within the System folder of the
computer.
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— From the “View External Video Using:” pull down, select the appropriate TARGA
Breakout Box option for your system.

Device Control Tab Settings
Final Cut Pro supports device control with the TARGA Ciné card.

— Refer to the Final Cut Pro documentation for information on using device control.
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Capture Tab Settings
Settings need to be made for Frame Size, QuickTime Video, and QuickTime Audio within
the Capture Tab for the TARGA Ciné card.

— Select the Frame Size “Aspect Ratio” that you want to use for video Capture.  The
aspect ratio is not the size of the capture; it is only for the size of the on-screen
display.  Pinnacle Systems recommendation is that “Multimedia Large (4:3)” is
selected for the aspect ratio because this setting saves bandwidth.

Once the aspect ratio for the frame size has been made, you need to set how the TARGA
Ciné card compresses and controls images via QuickTime.  This is done by way of the
Video dialog.

—From within the Capture Tab dialog click on the “Video” button.   The Video dialog
will be displayed.  The Video dialog allows you to:

• Make video compression settings
• Identify aspects of the video source
• Check disk performance
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Compression  -- From the pull down at the top left of the Video dialog, select
“Compression.”   The Video-Compression dialog will be displayed.  This dialog
allows for the selection of a compressor, and lets you adjust the compression ratio.

— Select the options as follows:

• Compressor:  TARGA Ciné YUV
• Depth:  Color
• Quality Slider:  Best
• Frames Per Second:  29.97 for NTSC  or 25 for PAL

Source  --  From the pull down at the top left of the Video dialog, select “Source.”
The Video-Source dialog will be displayed.  This dialog is used to identify the
digitizer, signal input, signal format, and filter.  The Digitizer and Input selections are
automatically set by the software to match the selections made in the TARGA Ciné
Control Panel.
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— The following options should be selected:

• Digitizer:  TARGA Ciné

• Input:  The type or types of TARGA Breakout Box connected will be shown here.
The choices displayed are dependent on the type(s) of TARGA Breakout Box you
selected in the TARGA Ciné Control Panel.

• Format:  This field will reflect the format for the type of equipment you selected in
the TARGA Ciné Control Panel.  NTSC will be displayed if you are using NTSC
equipment, or PAL if you are using PAL equipment.

Note:  To change the format type, you must quit the application and then make the change
in the TARGA Ciné Control Panel.

Disk Performance  --  From the pull down at the top left of the Video dialog, select
“Disk Performance.”   The Video-Disk Performance dialog will be displayed.  The
disk performance test is designed to simulate either standard definition or high
definition video activity to the disk drive array that you are capturing video to and/or
playing video from.  The frame size and speed of the type of video selected is
simulated and then measured.  The test provides an estimate of the achievable read
and write data rates, and the test is accurate to within about ±15%.
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— To use Disk Performance:

1. Use the “Select Drive” pull down to choose the drive that is to be tested.

2. Use the pull down below “Select Drive” to choose the type of video the
drive is being tested for.  Your choices are Standard or High-Definition.

3. Click the “Test” button on the dialog.

Note:  If you want to stop the test you are running, press the <esc> key.

If you are using audio, then after the settings for the Video dialog are made you need to set
how the TARGA Ciné card handles audio.  This is done by way of the Audio dialog.

—From within the Capture Tab dialog click on the “Audio” button.  The Audio dialog
will be displayed.  The Audio dialog allows you to:

• Make audio sample settings
• Identify aspects of the audio source
• Control the audio volume
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Sample  -- From the pull down at the top left of the Audio dialog, select “Sample.”
The Audio-Sample dialog will be displayed.  This dialog allows for the selection of
the audio bit size.  The audio sample rate selection should be 48,000 kHz.

The audio sample rate is the number of audio digital samples per second taken by the
TARGA Ciné card.  That is, the audio sampling rate is the number of times per
second that the amplitude of the sound wave (analog signal) is tested and recorded.
The more frequently the amplitude is sampled, the closer the sample values will
follow the wave form.  The TARGA Ciné records at 48,000 kHz, the highest
sampling rate possible.

The audio size is defined by bit depth.  The bit depth is the number of binary digits
(bits) used to specify the amplitude of each digital sample.  With more bits used, the
digital samples  more closely approach the true amplitude.  An 8-bit resolution
provides 256 levels (0-255), and a 16-bit resolution provides more than 65 thousand
levels (65,536).  Pinnacle Systems recommends you select recording at 16 bits.
Efficiency is actually decreased by selecting 8-bit sampling.

— Select the options as follows:

• Rate:  48,000 kHz
• Size:  16 Bits
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Source  --  From the pull down at the top left of the Audio dialog, select “Source.”
The Audio-Source dialog will be displayed.  This dialog is used to identify the audio
source device and audio input.

— Select the options as follows:

• Device:  TARGA Ciné

• Input:  This pull down will reflect the type or types of audio input available on the
TARGA Breakout Box you selected as being used.  (Select “Unbalanced” if RCA
jacks are used for audio, or “Balanced” if XLR jacks are used for audio.)   If you
have an SDI Breakout Box connected, the selection will include which stereo
group of the channels embedded on SDI are available for selection.

Speaker  --  You have the option of setting the audio input circuit of your TARGA
Breakout Box to “Off,” “On,” or “Off While Recording.”  If you plan to record audio,
set the pull down to “On.”

— Adjust the audio volume and audio gain as needed.

Note:  Gain is the attenuation of the input audio, and will work only with an analog signal
(i.e., analog breakout box).  For digital signals, the exact digital stream is recorded and the gain
can not be changed.
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Sequence Presets Tab Settings
A “Sequence Preset” in Final Cut Pro is a combination of settings for video, still images,
audio, and/or other media that has been saved for later use.  Sequence Presets are listed
and accessed from the Sequence Presets tab within the Preferences Menu of Final Cut Pro.
A new Sequence Preset could be created here for TARGA Ciné, or the existing TARGA
Ciné Preset can be duplicated and edited.  A NTSC (or PAL) preset has been pre-installed
for the TARGA Ciné.

Important:  The timebase of an existing Sequence Preset cannot be changed.  For example, an NTSC
Sequence Preset with a timebase of 29.97 cannot be edited to have a PAL timebase of 25 (or vice versa).

—To edit an existing TARGA Ciné preset, select the preset and then click the “Edit...”
button to make the dialog for the preset open.
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—Select from the Aspect Ratio pull down, Field Dominance pull down, and Pixel
Aspect Ratio pull down as follows for a TARGA Ciné with standard definition video:

• Frame Size Aspect Ratio:  CCIR 601 NTSC (40:27) or CCIR 601 / DV PAL (5:4)
• Field Dominance:  Lower (Even) if NTSC or Upper (Odd) if PAL
• Pixel Aspect Ratio:  NTSC - CCIR 601 /DV or PAL - CCIR 601
• Editing Timebase:  29.97 for NTSC or 25 for PAL

— For a TARGA Ciné with High Definition video, select from the Aspect Ratio pull
down, Field Dominance pull down, and Pixel Aspect Ratio pull down as follows:

• Frame Size Aspect Ratio: 1080 resolutions are always 1920 x 1080
720 resolutions are always 1280 x 720

• Field Dominance: For interlaced HD modes, dominance is “Top Field First”
For progressive HD modes, dominance is “None”

• Pixel Aspect Ratio:  HD is always square pixel

• Timebase:  Match the timebase to the HD format you are currently using.

NTSC For TARGA Ciné PAL For TARGA Ciné
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— Verify the “Video” and “Audio” settings.

HD For TARGA Ciné
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Scratch Disks Tab Settings
Make sure you are capturing video and audio to the correct disk drive array.  Refer to the
Final Cut Pro documentation for information on using the Scratch Disks tab settings.

Sequence Menu Of Final Cut Pro
The Sequence Menu in Final Cut Pro provides options for manipulating video, still
images, audio, and/or other media.  Settings specific for the TARGA Ciné card can be
made to an active sequence by selecting Sequence » Settings from the Final Cut Pro main
menu. Once this is done you should do the following:

— Confirm the Aspect Ratio, Field Dominance, and Pixel Aspect Ratio pull downs of
the sequence as follows in order to use the sequence with TARGA Ciné with minimal
rendering:

• Frame Size Aspect Ratio:  CCIR 601 NTSC (40:27) or CCIR 601 / DV PAL (5:4)
• Field Dominance:  Lower (Even) if NTSC or Upper (Odd) if PAL
• Pixel Aspect Ratio:  NTSC - CCIR 601 /DV or PAL - CCIR 601

— Verify the “Video” and “Audio” settings.

• Video Compressor:  TARGA Ciné YUV
• Frames Per Second: 29.97 for NTSC or 25 for PAL
• Sound Settings: 48,000 kHz at 16 Bits Stereo
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Adjusting The Video Image
In Final Cut Pro, adjustments can be made to how a video image looks.  The adjustments
are made by way of the “Log and Capture” dialog window, which is accessed from the
File Menu (File » Log and Capture » Clip Settings tab).   The sliders enabled within the
dialog window allow adjustments to be made to the video signal being sent as input to a
TARGA Breakout Box (i.e., before that signal is digitized by the TARGA Ciné card).

— The adjustments made available are dependent on the type of video format being
used.  For Composite and S-Video input the following slider adjustments are enabled:

• Hue
• Saturation
• Brightness
• Contrast

— For Component input the following slider adjustments are enabled:

• Saturation
• Brightness
• Contrast

— For digital inputs none of the sliders are enabled.  What comes in digitally as input is
exactly what is digitized by the TARGA Ciné card.
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External Video View Settings For TARGA Ciné
The TARGA Ciné engine stores video data (as frames) into a framebuffer (memory area)
on the Ciné card until that data is sent from the framebuffer as output. It is usually best to
let the TARGA Ciné decompressor decide how many frames should be stored into the
framebuffer before the frames are sent as output, but there may be circumstances where
you may want to “force” a decision onto the TARGA Ciné decompressor.  Final Cut Pro
allows a user to force such a decision on a decompressor by way of external video settings
which are found within the View Menu.

Off  --  This is the default setting and the overall best setting for compressed and
uncompressed video since it allows the decompressor to control how many frames
should be stored in the framebuffer.  This is the recommended mode for both
playback and scrubbing, and allows the desktop overlay display to be enabled during
playback.

All Frames  --  This setting “forces” the decompressor to place all of the frames
possible into the framebuffer.  This setting can be used with compressed video when a
DV device is connected via a 1394 cable, and the data from the DV device is what
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will be sent as output.  All Frames is also a good choice for scrubbing within a
timeline, or if you are compositing frames.  All Frames is not a good choice for
uncompressed playback since it can increase the likelihood of dropped frames and
thus degrade playback performance.

Single Frames  --  This setting “forces” the decompressor to place one frame at a time
into the framebuffer.  This is useful if individual frames need to viewed as they are
rendered.  The Single Frames setting allows you to see the output data on your output
device as it is rendered, but there is no desktop overlay displayed during the playback.
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CinéWave Settings Within Commotion Pro

Within Pinnacle Systems Commotion Pro software specific settings for CinéWave are
made from: the File Menu within “Preferences” and “Video Mirror,” and from within the
Composite Menu.  Once the CinéWave specific settings are made, use Commotion Pro as
you normally would for editing video.

Preferences Settings For CinéWave
The Preferences for Commotion Pro are accessed from the File Menu (File » Preferences).
Once Preferences are accessed, settings specific for the TARGA Ciné card occur within
the following dialogs:

• Render Settings
• Disk / Cache

Render Settings
Within the Preferences’ Render Settings of Commotion Pro, a setting should be made to
the DV Stream section of the dialog.  The “Hardware codec:” pull down indicates to
Commotion Pro the type of TARGA Breakout Box (or Boxes) connected to the TARGA
Ciné card.  The TARGA option(s) displayed will be what was chosen in the TARGA Ciné
Control Panel (“Ciné Board Info”) within the System folder of the computer.
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— From the “Hardware codec” pull down, select the appropriate TARGA Breakout Box
option for your system.

Scratch Disks Settings
Make sure you are capturing video to a high-performance disk drive array.  Refer to the
Commotion Pro documentation for information on using the Scratch Disks tab settings.
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Composite Menu Of Commotion Pro
Commotion Pro needs to be set to the video frame size that it will be compositing.  In
Commotion Pro, this is done in the Composite Menu within “Composite Settings”
(Composite » Composite Settings).

— Select the video frame size.  The following sizes are acceptable by the TARGA Ciné
with Commotion Pro:

• D1 720 x 480
• D1 / DV PAL 720 x 576
• 1280 x 720 HDTV
• 1920 x 1080 HDTV
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Using Video Mirror With CinéWave
CinéWave supports the “Video Mirror” feature of Commotion Pro.  Video Mirror can be
enabled from within the File Menu (File » Video Mirror).

— Refer to the Commotion Pro documentation for information on using “Video Mirror.”
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Occasionally, you may have a problem while using your CinéWave System.  This
Appendix covers potential situations and describes steps you can take to identify and
correct them.  CinéWave troubleshooting in this Appendix is subdivided into the following
categories:

• General Problems
• System Compatibility Problems
• Video Input Problems
• Recording Problems
• Audio Problems
• Playback Problems

Important:  Additional troubleshooting information discovered after this manual was printed can be
found in the “Read Me” file within the CinéWave folder.  If your problem is not solved by this
Troubleshooting section or the Read Me file, additional help can be obtained from the Pinnacle Systems
Customer Satisfaction Center.  Refer to the Customer Satisfaction Center section later in this Chapter.

General Problems

Audio Output Crackles Or Pops

1. Decrease the input level (or gain) within the video-editing application and recapture.

2. Input from device may be “hot.”  Reduce the audio level at the input device.

Audio And Video Not In Sync

1. Check your disk performance with the TARGA Ciné “Disk Performance” feature.
The disk you are capturing and playing from should be capable of reading and
writing at uncompressed video data rates.

2. Check your “Video Input” settings and “Audio Input” selections.

3. Make sure that all audio rates are set to 48,000 kHz at 16 bits.

Appendix A: Troubleshooting & Contacting Pinnacle Systems

CINÉWAVE TROUBLESHOOTING
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Poor Performance

1. For best performance, capture the video and audio to a hard disk array with at least
10,000 RPM Ultra 160 SCSI disks that have been designated as your video storage
drive.

2. Use Dual-Channel Bus-Mastering Ultra 160 SCSI Controllers.

3. Make sure the scratch files within the application’s “Preferences” are set to your AV
drive.

You have a SCSI boot drive (internal) and an A/V drive (external).  Your data rates
are not acceptable and occasionally the system freezes and lockups.

— Your problem is probably related to SCSI Termination. You should always use an
active terminator on the end of your SCSI chain. Another problem in this scenario is
that you may have placed your SCSI card in the middle of your SCSI chain.  This
will keep all the data moving in one direction with the source on one end
(i.e. SCSI controller) and with destinations (i.e., hard drives) on the other.  Although
the SCSI controller manufacturers show the original configuration as a viable one,
sustained high data-throughput negates this option.  Use an active terminator.  Most
drives typically include only passive termination.

— Avoid setting the SCSI ID to 0 or 7.  These ID’s are commonly used to identify
either a boot drive or the SCSI Controller itself.

Low Memory Situations

— Low Finder memory can cause numerous problems including poorly captured
videos, no audio in videos and crashes.  Be aware that there should be at least 2 MB
of memory available for the finder at all times.
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Video-Editing Application Is Inconsistent

— Sometimes, when an application is forced to stop abruptly, it can be left in an
“unknown” or “confused” state.  Evidence of this might be incorrect default settings
or failure in simple operations.

• If you suspect this has happened, quit the application.  Open the Preferences folder
(in the System folder) and drag that application’s Preferences file to the trash.  Then
empty the trash.  The next time you launch the application, it will create a new
Preferences file and you will need to recreate your settings.  (Final Cut Pro Preferences
can be located in the System's Preferences folder under Final Cut Pro Data.  The
filename is “Final Cut Pro Preferences”)

• Delete the TARGA Ciné and Sound Preferences file

• Rebuild the desktop by rebooting holding down the Command-Option keys.

• "Zap the PRAM" by holding down the Command-Option-P-R keys during reboot until
the system chimes 4 times.

The last video frame for either capture or play back  remains displayed on the video
output screen.

— This is normal with CinéWave.

Using Software-Only Compression

— The TARGA Cine does include a software codec that is active whenever hardware is
not installed.  You may install the TARGA Cine extension on any G4 machine and
compress and render TARGA Cine format movies.

Video Field Jitter

— Since the TARGA Ciné captures two fields of video for each frame, high-motion
frames will appear to jitter when they are grabbed or still-framed.  This is normal and
occurs with any product, high-end or low-end, that captures two fields per frame.
During normal video playback, this technique makes motion look smoother and more
realistic, indicating a high-quality capture system.
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System Compatibility Problems

Incompatible Systems

1.  Only the PowerMac G4/400 and above (including Multiprocessor models) are
recommended for use with the TARGA Ciné.

2.  Do not use a G4 upgrade card on a lower speed machine.  The system bus will not
reach the recommended performance.  G4 upgrade cards affect the processor speed
only, and not the PCI bus.  You may use the software codec to render media on
incompatible machines.

3.  See the ReadMe and www.pinnaclesys.com/CineWave for information on the
compatible SCSI controller cards and drive systems.  Currently, the Atto UL3D and
the Adaptec 39160 are the recommended hard disk controllers.  SoftRaid 2.2.2 or
higher and Atto ExpressRaid 2.3.2 and higher are the current recommendations.  The
Quantum Atlas 10K II's are recommended for HD work in Dual Channel
configurations with 8 total drives (4 per channel) formatted as RAID 0.

4.  For multiple displays, the ATI Nexus 128 is known compatible.  See
www.pinnaclesys.com/CineWave and the ReadMe for updated information as it
becomes available.

5.  Use a dual channel Ultra 160 SCSI controller instead of 2 PCI slots with seperate
SCSI controller cards.
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Video Input Problems

Live Video Does Not Work

1.  Verify that you have all of the software components correctly installed.

2.  Make sure the software is set to match your video format and source signal.

• NTSC or PAL format with  SDI, Component, S-Video, or Composite signal.

3.  Check your video source.

• Some video cameras shut off automatically after a few minutes.

4.  Check the cable from the video source to your TARGA Ciné card.

5.  Make sure to set the Monitors Control Panel to “Millions of Colors.”

Can’t Get Video in the Preview or Capture Windows

— This is normal.  CinéWave is designed to display a graphic on the desktop monitor,
and video on the output monitor.

Drop Frames on Record

1. Record to the fastest array or drive.  Setup “Scratch Disks” within the “Preferences”
of your video-editing application

2. Check your disk performance with the TARGA Ciné “Disk Performance” feature.
The disk you are capturing and playing from should be compatible for the test results.
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Recording Problems

CinéWave Records Nothing or only a Few Frames

1. Verify that all necessary software is installed.

• Make sure you are using System 9.0 or greater.

• Use the version of QuickTime that was provided with the CinéWave software.

• The application you are using must be compatible with the QuickTime version being
used in the computer.

2.  Check the video signal.

• You should see video playing on the output monitor before you try to record.

• Make sure to set the Monitors Control Panel to “Millions of Colors.”

Unable To Switch Formats (NTSC, PAL, HD)

— This is normal.  The change has to be made in the TARGA Ciné Control Panel which
is found in the Control Panel folder.  Restart the application after making the change.

Unable To Record More Than 2 Gigabytes

— This occurs when the drive is formatted with the HFS format instead of HFS+.
Convert the drive to HFS+ to support longer file recording.

Video Doesn’t Record at Full Speed

1.  Use TARGA Ciné YUV compression format.

2.  If you have more than one multimedia card, make sure the correct source is selected.
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Audio Problems

Audio Output Crackles Or Pops

1. Decrease the input level (or gain) within the video-editing application.

2. Input from device may be “hot.”  Reduce the audio level at the input device and
recapture.

3. Check your disk performance with the TARGA Ciné “Disk Performance” feature.
The disk you are capturing and playing from should be compatible for the test
results.

No Sound On Playback

— Make sure sound output device in Sound Control Panel is set to TARGA, and then
confirm by playing a system sound which should be heard on the external speakers.

Sound Will Not Record

1. Make sure sound input in your application is set to the correct source.

2. Make sure sound input device in Sound Control Panel is set to TARGA, and then
confirm by recording a new system sound and playing it back.

Sound Too Low When Recording

1. Turn speaker “On” in Sound Out of your application.

2. Turn volume up in Sound Out of your application.

Audio Is Distorted Or Clipping

— Turn Gain down in Sound Input of your application.
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Playback Problems

Video Doesn’t Play at the Full Frame Rate or Pauses
Intermittently

1.  Verify that the video is in the TARGA Ciné video format.  If it is not, convert it to
the TARGA Ciné video format. (Note:  Simply converting the video will not change
its frame rate.)

2.  Check that the video is playing entirely on the screen of the TARGA-connected
display system.

• If even a portion of the video window is on an adjacent screen, the software goes
into still-decompression mode.

3.  Check that you are using the correct playback format: NTSC or PAL.

4. Verify the video frame rate.

5.  Free as much RAM as possible.  (Quit other applications.)

6.  Check that AppleTalk is turned off and all unnecessary Extensions and Control
Panels are disabled.

7.  Verify that the video is playing from the drive connected to the SCSI Accelerator
Card.

8. Close the Capture Window if it is open.

9.  Make certain "File Sharing" is off when recording or playing movies.

10. If you are not connected to a network, then check your TCP/IP settings.

If you are on a network without a DHCP server, make sure you are not using DHCP
services (which can be accomplished by assigning a fixed IP address to the
machine).  The network will poll for the presence of a network IP server, which
affects performance.
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Application Won’t Playback Captured Video

— Check that the application’s playback feature is correctly set.

Video Doesn’t Look Right During Playback

1. Check TARGA Ciné Control Panel settings.

2.  Make sure to set the display to “Millions of Colors.”

Playback Is Very Slow

1.  Make sure to set the display to “Millions of Colors.”

2. Move any windows overlapping the playback window (even palettes).

Drop Frames on Playback

— Check your disk performance with the TARGA Ciné “Disk Performance” feature.
The disk you are capturing and playing from should be compatible for the test results.

Problems with Taped Output

1. Check cabling.

2. You may need to have a Time Based Correction unit between the card and your
recording device.
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You can contact the Pinnacle Systems Customer Satisfaction Center (next page) for
additional help.  Before contacting the Customer Satisfaction Center, please complete the
Troubleshooting Questionnaire below and have the answers ready before you contact us.

On-line services are available 24 hours per day.  Customer Satisfaction Center personnel
are available Monday through Friday 9:00 A.M. to 9:00 P.M. Eastern Time
(1300 - 0100 Universal Time/GMT).

Troubleshooting Questionnaire
Please have answers to the following questions before calling for additional help:

1. What are the serial numbers, model numbers, and software version numbers of the
Pinnacle Systems products that you have installed on your computer?

2. Which computer system are you using with the product listed in item 1 of this
questionnaire?

3. What version of the Apple OS are you using?

4. How much memory (RAM) is installed in your computer?

5. What background/scheduled tasks are installed and running on your computer?

6. What other hardware is connected to your computer (multimedia cards, monitors,
network cards, hard drives, etc.).  Please include all relevant model numbers, ROM
version numbers, and software version numbers where applicable.

7. What are the steps to duplicate the problem?

Pinnacle Systems Customer Satisfaction Center
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Contacting Pinnacle Systems

On-Line Services

E-mail: targa-support@pinnaclesys.com

WWW Site: www.pinnaclesys.com

Fax Inquires

U.S. and Canada: (317) 576-7770
Worldwide: (317) 594-2900

Telephone Contact

Sales Information: (877) 733-5846 within United States and Canada

Technical Support: (317) 577-8788

Note:  This information is subject to change.  Check www.pinnaclesys.com on the web for the latest contact
information.
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Appendix B: TARGA Pro Analog Rack Mount Assembly

Pro Analog Breakout Box Rack Mount Installation

The rack mounting hardware for the TARGA Pro Analog Breakout Box is designed to fit
cabinets with 19-inch wide racks.  Pinnacle Systems recommends that the mounting
bracket specifically designed for the TARGA Pro Analog Breakout Box be used for
mounting purposes.

Rack Mounting Hardware:
• Mounting Bracket
• Miscellaneous items (screws)

Equipment Needed:
• Small and Medium sized phillips-head screwdriver

Procedure:

1. Turn off your computer and then disconnect the Pro Analog Breakout Box cable
from the TARGA card .
Remove any other cables attached to the Pro Analog Breakout Box.

2. Place the Pro Analog Breakout Box upside down on a convenient work surface.

3. Remove the four screws from the metal plate.
Do NOT remove the metal plate itself.  Refer to Figures 1 and 2.

Figure 1 Figure 2
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4. Place the rack mount bracket over the Pro Analog Breakout Box as shown
(Figure 3).

5. Using the four screws supplied with the bracket (Figure 4), attach the rack mount
bracket to the Pro Analog Breakout Box (Figure 5).
Align the holes in the bracket, metal plate, and Pro Analog Breakout Box.  Then insert
the screws and turn them down some.  Do not completely tighten the screws yet.

Figure 3

Figure 4 Figure 5
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6. Center the Pro Analog Breakout Box in the rack mount bracket as shown in
Figure 6 and Figure 7.
Note that if your position is different from these, you may have difficulty sliding the
entire assembly into the rack.

7. Now tighten the four screws inserted in Step 5.
Be careful not to overtighten the screws.

8. Place the Pro Analog Breakout Box and rack mount bracket assembly into the
rack as shown in Figure 8.

Figure 8

Figure 7Figure 6
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9. Attach the rack mount bracket assembly with the screws included with the
rack-mount kit onto the rack (Figure 9).
This completes the rack installation.

Note:  A rear-facing installation is also possible.  The Pro Analog Breakout Box may be mounted to a
rack’s rear rails.  The rear-facing installation is advantageous for direct connection of VTRs to the Pro
Analog Breakout Box.

Figure 9
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The specifications for CinéWave are divided into four sections within this Appendix:

• TARGA Ciné Card Only
• TARGA Pro Analog Breakout Box Only
• TARGA Pro Digital Breakout Box Only
• TARGA Pro HD Digital Breakout Box Only

TARGA Ciné Card Only

General
Card Size ........................................7.5" x 5.0"

Bus Interface...................................1 PCI slot

Power Consumption .......................4.7 Watts max
--  0.12A @ +12v DC
--  0.00A @ -12v DC
--  0.35A @ +5v DC
--  0.45A @ +3.3v DC

Regulatory Compliance ..................FCC Class A and CE

Connectors......................................2 HD 36-pin Digital Tether™ Female Receptacles

Memory
Frame Buffer Memory....................128 MB SDRAM

Color Tables
Color Correction Tables .................256 x 15 bits for each primary

Appendix C: TARGA Ciné Technical Specifications

Technical Specifications*

*All specifications subject to change without notice.
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Video Processor
Video Resizer .................................2D sub-pixel filter

Video Compositor ..........................1024 levels

Color Space Converter ...................10-bit transparent

Supported Clock Rates
Standard Definition Video..............27 MHz Clock Frequency

High Definition Video....................74.176 MHz Clock Frequency

High Definition Video....................74.250 MHz Clock Frequency
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TARGA Pro Analog Breakout Box Only

General

Width -- 12.0" ( 19.0" w/rack mount bracket)
Height -- 3.5"
Depth -- 3.8"
Weight -- 2.5 lb. (1.0 Kg.)

Power Supply -- Power is supplied from Digital Tether™ cable at 6.8 Watts max
Input Current -- 0.20A @ +12vDC

-- 0.07A @ -12vDC
-- 0.50A @ +5v DC
-- 0.30A @ +3.3v DC

Ambient Temperature -- Operating at 0 to 40° C

Ambient Humidity -- Operating at 0 to 90% non-condensing

Mounting Option -- Detachable (bracket for mounting in a 19.0" wide rack)

Sampling Structure -- I.T.U. 656, 8 Bit, 4:2:2, Component

Sampling Frequency -- Y:  13.5 MHz
B-Y, R-Y:  6.75 MHz

Video Input

CV, Y/C -- 8 bit, 4:2:2 spatial resolution
-- Gain and offset controls
-- Saturation controls
-- CV input passes through a comb filter

* CV 1.0 V p-p, 75 Ω , BNC
* S-Video Y:  1.0V p-p

C:  627mV p-p
4-pin DIN

*Output levels are based on NTSC 100% white 75% amplitude fully saturated bars.
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Component
(Y, B-Y, R-Y) -- 8 bit, 4:2:2 spatial resolution

-- Input gain and offset controls

* Y 1.0 V p-p, 75 Ω  BNC
* B-Y +/- 350mV p-p, 75 Ω , BNC
* R-Y +/- 350mV p-p, 75 Ω , BNC

Genlock Reference -- Input is 1Vpp, 75 Ω, BNC (REF)

Supported Formats: -- Composite  (NTSC, NTSC-J, PAL)
-- S-Video  (NTSC, NTSC-J, PAL)
-- Y,B-Y,R-Y  (NTSC Betacam, NTSC Betacam-J, SMPTE/EBU)

Video Output

Supported Formats -- Composite  (NTSC, NTSC-J, PAL)
-- S-Video  (NTSC, NTSC-J, PAL)
-- Y,B-Y,R-Y  (NTSC Betacam, NTSC Betacam-J, SMPTE/EBU)

CV, Y/C -- Interpolates 8 bit data path to a 10 bit DAC resolution
-- Supports NTSC, NTSC-J and PAL
-- Output phase control

* CV 1.0 V p-p, 75 Ω , BNC
* S-Video Y:  1.0V p-p

C:  627mV p-p
4-pin DIN

Component
(Y, B-Y, R-Y) -- Interpolates 8 bit data path to a 10 bit DAC resolution

-- Output gain offset & saturation control

* Y 1.0 V p-p, 75 Ω , BNC
* B-Y +/- 350mVp-p, 75 Ω , BNC
* R-Y +/- 350mVp-p, 75 Ω , BNC

* Levels are based on NTSC 100% white, 75% fully saturated bars.
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Audio Input

Balanced Inputs -- Channel 1 (left) 1 x XLR, line level, +4dBu, nominal
-- Channel 2 (right) 1 x XLR, line level, +4dBu, nominal
-- Headroom 20 dBu above nominal
-- Input Impedance 10 kΩ
-- 24 bit ADC resolution
-- Audio to Video Sync  < 1mS
-- Sample Rate 48 kHz

Unbalanced Inputs -- Channel 1 (left) 1 x RCA, -10 dBu, nominal
-- Channel 2 (right) 1 x RCA, -10 dBu, nominal
-- Headroom 28 dBu above nominal
-- Input Impedance 20 kΩ
-- 24 bit ADC resolution
-- Audio to Video Sync  < 1mS
-- Sample Rate 48 kHz

Audio Output

Balanced Outputs -- Channel 1 (left) 1 x XLR, line level, +4dBu nominal to 600 Ω  load
-- Channel 2 (right) 1 x XLR, line level, +4dBu nominal to 600 Ω  load
-- Headroom  20 dBu above nominal
-- 24 bit DAC resolution

Unbalanced Outputs -- Channel 1 (left) 1 x RCA, -10 dBu nominal
-- Channel 2 (right) 1 x RCA, -10 dBu nominal
-- Headroom  28 dBu above nominal
-- 24 bit DAC resolution
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TARGA Pro Digital Breakout Box Only

General

Width -- 2.2"
Height -- 3.7"
Depth -- 0.9"
Weight -- 2.5 oz. (0.34 Kg.)

Power Supply -- Power is suppled from Digital Tether™ cable at 3.6 Watts max
Input Current -- 0.08A @ +12vDC

-- 0.00A @ -12vDC
-- 0.35A @ +5v DC
-- 0.25A @ +3.3v DC

Ambient Temperature -- Operating at 0 to 40° C

Ambient Humidity -- Operating at 0 to 90% non-condensing

Video Input

Standards Conformance -- ITU-R BT.656;  SMPTE 125M;  259M

SDI -- Input impedance at 75 Ω
-- Return loss greater than 15dB from 5 MHz to 270 MHz
-- Resolution at 8/10 bits
-- Bit rate at 270 Mb/sec

Video Output

Standards Conformance -- ITU-R BT.656;  SMPTE 125M;  259M

SDI -- Amplitude at 800 mV p-p, ± 10% into 75 Ω
-- Overshoot at ≤ 10%
-- Rise and fall times at 0.4 to 1.5 ns
-- Jitter ≤ 0.2 UI p-p total for all frequencies above 10 Hz
-- Resolution at 8/10 bits
-- Bit rate at 270 Mb/sec
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SDI Embedded Audio Input

Standards Conformance -- SMPTE  272M

Number Of Channels -- 8 channels in 2 groups;  4 AES/EBU audio pairs

Frequency -- 48 kHz

Quantization -- 20 bits/sample

SDI Embedded Audio Output

Standards Conformance -- SMPTE  272M

Number Of Channels -- 8 channels in 2 groups;  4 AES/EBU audio pairs

Frequency -- 48 kHz

Quantization -- 20 bits/sample
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TARGA Pro HD Digital Breakout Box Only

General

Width -- 3.4"
Height -- 1.75" (1U)
Depth -- 5.5"
Weight -- 20 oz. (0.56 Kg.)

Power Supply -- Power is suppled from Digital Tether™ cable at 5.5 Watts max
Input Current -- 0.06A @ +12vDC

-- 0.00A @ -12vDC
-- 0.75A @ +5v DC
-- 0.31A @ +3.3v DC

Ambient Temperature -- Operating at 0 to 40° C

Ambient Humidity -- Operating at 0 to 90% non-condensing

Video Input

Standards Conformance -- ITU-R BT.656;  SMPTE 292M;  296M;  274M (including proposed
segemented frame)

SDI -- Input impedance at 75 Ω
-- Return loss greater than 15dB from 5 MHz to 1500 MHz
-- Resolution at 8/10 bits
-- Clock rate at 74.25 MHz or 74.176 MHz
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Video Output

Standards Conformance -- ITU-R BT.656;  SMPTE 292M;  296M;  274M (including proposed
segemented frame)

SDI -- Amplitude at 800 mV p-p, ± 10% into 75 Ω
-- Overshoot at ≤ 10%
-- Rise and fall times at less than 270 ps
-- Jitter ≤ 0.2 UI p-p total for all frequencies above 10 Hz
-- Resolution at 8/10 bits
-- Clock rate at 74.250 MHz or 74.176 MHz

SDI Embedded Audio Input

Standards Conformance -- SMPTE  299M

Number Of Channels -- 8 channels in 2 groups

Frequency -- 48 kHz

Quantization -- 20 bits/sample

SDI Embedded Audio Output

Standards Conformance -- SMPTE  299M

Number Of Channels -- 8 channels in 2 groups

Frequency -- 48 kHz

Quantization -- 20 bits/sample



C-10 Appendix C: TARGA Ciné Technical Specifications



Pinnacle Systems CinéWave Index-1

Index

Symbols

525 Line SDI  2-4
625 Line SDI  2-4

A

Adjusting Video Image (Final Cut Pro)  3-13
Adobe Acrobat  2-2
Adobe Acrobat Reader  2-1, 2-2
Analog Breakout Box  1-7
Anti-Static Wrist Strap  1-1, 1-4
Audio Bit Depth (Final Cut Pro)  3-7
Audio Input (Specifications)  C-5
Audio Output (Specifications)  C-5
Audio Problems  A-1, A-7
Audio Sample Rate (Final Cut Pro)  3-7
Audio Source Dialog (Final Cut Pro)  3-8

B

Breakout Box  1-13
Breakout Box Rack Mounting  1-9
Breakout Boxes (Types)  2-3

C

Card Size  C-1
Ciné Board Info  2-3, 3-1
CinéWave Pro Digital Breakout Option  1-16
CinéWave Software CD-ROM  2-1
Clock Rates (Specifications)  C-2
Color Correction Tables  C-1
Color Tables (Specifications)  C-1
Com(B)  1-9
Commotion Pro  x, 3-1, 3-16
Commotion Pro (Composite Menu)  3-18
Commotion Pro (Render Settings)  3-16
Commotion Pro (Scratch Disks Settings)  3-17

Commotion Pro (Video Mirror)  3-19
Commotion Pro Preferences  3-16
Composite  1-9
Composite Menu (Commotion Pro)  3-18
Composite Settings (Commotion Pro)  3-18
Configuring TARGA Ciné  ix, 2-3
Connecting Audio/Video I/O Devices  1-13
Connecting Input Devices  1-10
Connecting Pro Digital Breakout  1-13
Connecting Pro HD Digital  1-16
Contacting Pinnacle Systems  A-1, A-11
Customer Satisfaction Center  A-10

D

Digital Breakout Box  1-7
Digital Tether  1-2, 1-7
Digital Tether Cable  1-13, 1-16
Digital Tether Connector  1-2

E

Expansion Slots (G4 Computer)  1-5
External Video View (All Frames)  3-14
External Video View (Off)  3-14
External Video View (Single Frames)  3-15

F

Fax Inquires (Pinnacle Systems)  A-11
FCC  v
Final Cut Pro  x, 3-1
Final Cut Pro (Aspect Ratio)  3-3
Final Cut Pro (Audio Dialog)  3-7
Final Cut Pro (Audio Source)  3-8
Final Cut Pro (Capture Settings)  3-3
Final Cut Pro (Compression)  3-4
Final Cut Pro (Device Control Settings)  3-2
Final Cut Pro (Disk Performance)  3-5



IndexIndex-2

Final Cut Pro (General Settings)  3-1
Final Cut Pro (Scratch Disks Settings)  3-12
Final Cut Pro (Sequence Menu)  3-12
Final Cut Pro (Sequence Presets Settings)  3-9
Final Cut Pro (Source)  3-4
Final Cut Pro (Video Dialog)  3-3
Final Cut Pro Preferences  3-1

G

General Problems  A-1
Genlock Settings  2-5

H

Hardware Installation  1-3
HD 1080i/29.97  2-4
HD 1080p/23.98  2-4
HD 1080PSF/23.98  2-4
HD 720p/59.94  2-4
High Definition  ix, 1-16

I

Input Devices (Connecting)  1-10
Installation Procedure  1-3
Installing TARGA Ciné Card  ix

L

License Agreement  vii
Limitation Of  Liabilities  vii
Limited Warranty  vii

M

Master/Freerun  2-5
Memory (Specifications)  C-1
Millions of Colors (G4 Computer)  2-1

N

NTSC Component  2-4
NTSC Composite  2-4
NTSC S-Video  2-4
NTSC-J Component  2-4
NTSC-J Composite  2-4
NTSC-J S-Video  2-4

O

Official Notices  v
On-Line Services (Pinnacle Systems)  A-11
Output Devices (Connecting)  1-10
Overview  1-3

P

PAL Component  2-4
PAL Composite  2-4
PAL S-Video  2-4
Patents  2
PDF Reader  2-2
Playback Problems  A-1, A-8
Power Consumption  C-1
Preferences Settings (Commotion Pro)  3-16
Pro Analog and Digital  2-3
Pro Analog Breakout Box  x, 1-8
Pro Analog Breakout Box (Specifications)  C-3
Pro Analog Breakout Box Connections  1-8
Pro Digital  2-3
Pro Digital Breakout Box  1-13
Pro Digital Breakout Box (Specifications)  C-6, C-8
Pro HD Digital  2-3
Pro HD Digital Breakout Option  1-16



Pinnacle Systems CinéWave Index-3

R

Rack Mount Bracket  B-3, B-4
Rack Mounting  x, 1-9, B-1
Rack Mounting Hardware  B-1
RCA Audio  1-8
Recording Problems  A-6
REF  1-9
Registration Card  ix
Regulatory Compliance  C-1

S

S-Video  1-8
SDI  1-13
SDI Embedded Audio Input (Specifications)  C-

7, C-9
SDI Embedded Audio Output (Specifications)  C-

7, C-9
Sequence Menu (Final Cut Pro)  3-12
Serial Digital  1-13
Software Installation  2-2
Software Setup  2-1
Sound Control Panel  2-3, 2-6
Sound Input  2-6
Sound Output  2-6
Speaker Selections (Final Cut Pro)  3-8
Standard Definition  ix
Supported Clock Rates  C-2

T

Table Of Contents  i
TARGA  ix
TARGA Analog  2-3
TARGA Breakout Boxes (Types)  2-3
TARGA Ciné  ix, 1-13, 3-1
TARGA Ciné Card  1-1, 1-7

TARGA Ciné Connectors  C-1
TARGA Ciné Control Panel  2-3
TARGA Ciné Framebuffer  3-14
TARGA Ciné Sound Input  2-6
TARGA Ciné Sound Output  2-6
TARGA Ciné Video Inputs  2-4
Technical Specifications  C-1
Telephone Contact (Pinnacle Systems  A-11
Trademarks  2
Troubleshooting  A-1
Troubleshooting Questionnaire  A-10

V

Video Capture Problems  A-1
Video Input (Specifications)  C-3, C-6, C-8
Video Input Problems  A-1, A-4, A-5
Video Mirror (Commotion Pro)  3-19
Video Output (Specifications)  C-4, C-6, C-9
Video Processor  C-2
Video Settings  2-4
Video-Editing Applications  3-1
View Settings (Final Cut Pro)  3-14
Virtual Memory (G4 Computer)  2-1

W

Warranties  v
Warranty Disclaimer  vii

X

XLR Audio  1-8

Y

Y   B-Y   R-Y  1-8



IndexIndex-4




